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1. Introduction 

Preface. MacAnova is an interactive computer program for the analysis of 
. linear models, primarily designed experiments. It features a syntax for entering, 

modifying, combining, and selecting data; graphical functions for plotting data 
and results; a grammar for specifying linear models; and numerical functions for 
fitting linear models to data. MacAnova was created in 1987 by Gary W. Oehlert of 
the Department of Applied Statistics, University of Minnesota to provide for the 
design and analysis of experiments on Macintosh microcomputers in a classroom 
environment. This manual refers to Version 1.0 ofMacAnova. 

Development of MacAnova was supported in part by the grant of an Apple 
Macintosh computer by the Minnemac Project at the University of Minnesota. 
Several colleagues, most notably Luke Tierney, Sandy Weisberg, and Christopher 
Bingham, have provided valuable suggestions and recommendations during the 
development ofMacAnova. Jay Andersen (supported by an EDP grant from the 
University of Minnesota) provided the code for computing cumulative distribution 
functions, the plotting routines are adapted from GNUplot, and most Macintosh 
features are obtained from the TransSkel environment. The students in my 
Spring 1987 Statistics 5301 and 5163 classes survived (suffered through) early 
versions of MacAnova and provided several useful suggestions. 

The syntax for MacAnova is modeled after S (Becker and Chambers 1984) but 
does not contain all the constructs in S. The parser, written in yacc (a compiler 
compiler available in UNIX), evolved from hoc, a desk calculator written also 
written in yacc (Kernighan and Pike 1984). The syntax for specifying linear 
models is taken from GLIM (Aitken et al. 1986). 

Disclaimer. Effort has been made to make MacAnova as error free as 
possible, but the program is rapidly evolving and has not yet been extensively 
tested. Neither the University of Minnesota, nor the Department of Applied 
Statistics, nor the author of this program claims any responsibility for errors that 
may arise from this program. 

Comments on Version 1.0. MacAnova was originally intended to have much 
more design and much less analysis. However, I felt it was necessary to start out 
with the analysis aspects first so that the students using it would not be losing 
ground with respect to the data analysis capabilities available in prior computing 
environments. Future versions of MacAnova will try to remedy this imbalance. 

The anovacoef s () function really needs to be revised so that the output format 
gives exactly the information wanted, rather than an awkward linear 
combination of it. (But if you think the explanation in Section 3 is complicated, you 
should try programming the general case!) 
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2. The Basics 

Getting Started. Turn the computer on and insert a disk with MacAnova 
into the disk drive. If the disk icon is not open, open it. Now launch MacAnova by 
double clicking on the MacAnova icon. MacAnova will start up with a MacAnova 
Command Window as shown below. Commands to MacAnova are entered in two 
ways: typing text from the keyboard, and selecting an item from a menu. Text 
typed from the keyboard is entered into the command window at the insertion 
point (marked by a flashing vertical bar I ), and backspacing erases text. 
MacAnova examines the text typed after the prompt ( cmd> ) and processes the text 
as a command when a Return is typed. If you have a very long command, just 
keep typing (the typed characters will wrap around to the next line) and enter a 
Return when the command is done. You may enter more than one command on a 
single command line by separating the commands with semicolons. 

,. S File Edit 

Welcome to MacAnova! 

Cmd> I 

MocAnouo Command Window 

., 

o· -

Quitting. To exit MacAnova, select Quit from the File menu. This will stop 
MacAnova and return you to the desktop. Alternatively, select Quit & save output 
from the File menu. This will also stop MacAnova, but the contents of the 
command window are saved into a file called SPOOLFILE. (If SPOOLFILE 
already exists, the contents on the command window will be appended onto the 
end of the file.) This file may be printed or edited using MacWrite or MockWrite. 
When using either type of Quit, all of the variables in MacAnova's memory will 
disappear when you exit MacAnova. (But see save () and restore () in Section 4.) 

u 

Doing work. Between starting and stopping MacAnova, you probably want to 
get some work done. MacAnova commands are "functional". That means that 
commands are functions which have arguments (inputs) and return values 
(outputs). (Some functions have "side effects" -- related variables that are set up or 
deleted by the function. Residuals in regression and anova are examples of side 
effects.) The functions in MacAnova include statistical functions like an ova ( which 
does analysis of variance calculations) and describe (which does descriptive 
statistics like mean, variance, and quartiles), arthimetic functions like log, exp, 
+, -, etc., and housekeeping functions for reading and creating variables, U 
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deleting variables and so forth. If the output from one function makes sense as 
the input to another, the functions may be composed (strung together). Thus 
describe (log (x+3)) takes the data in x, adds three to it, takes the log of the sum, 
and then computes descriptive statistics on the logged values. 

Variables. Data are stored in variables with user selected names up to 12 
characters in length. Names must begin with a letter, but subsequent characters 
may be numbers as well as letters. Variable names are case sensitive, which 
means that residuals, Residuals, and RESIDUALS are all different names. It is a 
good idea to avoid names with capital letters, as MacAnova deletes and creates 
some variables with all capital names (eg, RESIDUALS). 

There are several data types in MacAnova, but the most common are Real, 
Logical, and Character. Real data are just numbers like 2.4, -1, and 3.14159. Real 
data are allowed to take "missing values". When typed from the keyboard, the 
missing value code is a question mark, ?; when printed, a missing value prints as 
MISSING. Logical data indicate true or false and are symbolically represented by T 
and F. (There are system variables named T and F, which are logical variables 
with the values true and false respectively.) Character data are strings of 
characters. When typing character data on the keyboard, the character strings 
should be surrounded by double quotes, e.g. "this is a character string". Note: 
any character is allowed inside a Character variable except a double gyote, even a 
Return character. One common source of trouble is forgetting to add the closing 
double quote to a character variable, hitting Return, and expecting MacAnova to 
respond. Without the closing double quote, MacAnova is just waiting for more 
characters to put inside the string variable. 

Real, Logical, and Character data can be organized as scalars (a single 
datum), vectors (a column of data), matrices, and more generally as arrays of up 
to 10 dimensions. 

Syntax. MacAnova is a functional language and its syntax is functional. 
Variables may be processed via functions, and the output of functions may be 
combined if the outputs are compatible. Functions look like a function-name 
followed by a comma separated list of arguments in parentheses, e.g. 
boxplot (x, y, z). Parentheses also indicate grouping or the order in which 
operations should be performed. Spaces between semantic units (like numbers or 
variable names) are ignored, but spaces within semantic units cause errors. 

Arithmetic on Real data is simple. You may add, subtract, multiply, divide, 
and raise to a power in natural expressions by using the functions +, -, *, /, and " 
respectively. Addition and subtraction have lower precedence than multiplication 
and division which have lower precedence than raising to a power. Thus (1+2) *3 
is 9, but 1+2*3 is 7, and 2"3*2 is 16, but 2" (3*2) is 64. The functions abs, log, loglO, 
and exp provide absolute value, natural log, log base 10, and exponential functions. 
So, abs (3-5) +loglO (10)' is 3. 

Logical data are entered via T and F or generated via logical expressions on 
Real or Logical data. The logical expressions for Real data are equals = , not 
equals ! = , less than < , greater than > , less than or equal to <= , and greater 
than or equal to >=. Thus 2=1, 3 != 3, 2 >= 5, and 3 < 1 all have the value false, 
while 2=2, 3 != 2, and 3 > -1 all have the value true. Logical values maybe 
combined using logical and & , logical or I , and logical not ! . Thus, F & T, F 

I F, and ! Tall have the value false, while F I T and ! F have the value true. 
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Assignment. Assigning a value to a variable is a function. In MacAnova, a 
left pointing arrow <- (the symbols "greater than" and "hyphen") indicates U 
assignment: 

Cnd> x<-6 

makes x a scalar containing the real value 6. Any subsequent use of x will have 
the same effect as using the number 6; e.g. x+ 2 is 8. Character and logical data 
may be assigned in the same way: 

Cnd> department<- "Applied Statistics" 

Cnd> true<- T 

In addition to making the assignment, assignment functions have a value equal to 
the value of the assigned variable. Among other things, this allows us to save 
intermediate values on the fly: 

Cnd> y<-{x<-6)+8 

Cnd> u<-w<-6+8 

assigns 6 to x and 14 to y, u, and w. 
If no assignment is made, the value of a command is printed: 

Cnd> 3*5 
(1) 15 

results in 15 being printed, but 

Cnd> x<-3*5 

Cnd> 

does not print anything. The command 

Clnd> X 
(1) 15 

would then print 15. 
The function list () will print a list of all currently defined variable names 

along with their types and dimensions. There are several built-in variables 
including T (true), F (false), E (the natural base), PI (T(), and DEGPERRAD (the number 
of degress per radian). The function delete () will remove a list of variables. Thus 

Cnd> delete(E,PI) 

will remove the built-in variables E and PI from the variable list. 

Vectors, etc. Vectors are formed using the function cat (short for 
concatenate). The expression cat Cl, 2, 3, 5, 5) has a value which is a Real vector 
oflength 4, and z<-cat (1, 7, 4, 9, 6) makes z a Real vector oflength 5 with elements 

u 

1, 7, 4, 9, 6. Ifwe typed z2<-cat (z, z), then z2 would be a Real vector oflength 10 V 
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containi:r;tg two copies of the old z. 
Elements of a vector may be selected in one of two ways. First, a specific list 

of elements may be given inside square brackets. Thus z [ 4] has the value 9, and 
z [cat (1, 1, 2, 2, 4, s, 3)] is a Real vector with elements 1,1,7,7,9,6,4. Second, a 
logical vector of the same length as the source vector may be given in square 
brackets, and the value will be a vector with elements corresponding to the T 
elements in the logical vector. For z given above, z>4 is a logical vector with 
elements F,T,F,T,T and z [z>4] is a vector with elements 7,9,6. 

Lets repeat these examples and see what the MacAnova output looks like. 

Ond> z<-cat(l,7,4,9,6) 

Ond> z 
(1) 1 

Ond> cat(z,z) 
(1) 1 
(6) 1 

Ond> z [4] 
(1) 9 

Ond> z[cat(l,1,2,2,4,5,3)] 
(1) 1 
(6) 6 

Ond> z>4 
(1) 

Ond> z[z>4] 
(l) 

F 

7 

7 

7 
7 

1 
4 

T 

9 

4 

4 
4 

7 

F 

6 

9 

9· 
9 

7 

T 

6 

6 
6 

9 

T 

Five values are printed per row when Real or Logical data are being printed. The 
number in parentheses on the left under the Cmd> prompt is the subscript or index 
of the first element printed in that row. 

Matrices are formed using the function matrix which takes two arguments. 
The first is a vector of elements to go into the matrix, the second is the number of 
rows in the matrix. Data go into the matrix column by column. 

Ond> q<-matrix(cat(l,2,3,4,5,6),3) 

Ond> q 
(1, 1) 
(2, 1) 
(3, 1) 

1 
2 
3 

4 
5 
6 

· Matrices are printed row by row with up to five numbers printed per line. The 
numbers in parentheses at the beginning of each output line give the matrix 
subscripts of the first element of the line. 

Elements of matrices may be accessed in an analogous manner to vectors 
except that you must specify both rows and columns. Hence q c 3, 1] is the first' 
column of the third row and q [ cat C 1, 2 > , 2] is the second column of the first and 
second rows. An empty row or column specification implies all rows or columns. 
Thus q[3, J is the third row. Elements of matrices retain both of their subscripts. 
The selected elements can be turned into an ordinary (one dimensional) vector by 
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using the function cat; cat (q [ 3, J) is a vector. 

and> q[3, 1J 
(1, 1) 3 

and> q[, 2J 
(1, 1) 4 
(2, 1) 5 
(3, 1) 6 

and> q[cat(l,2),2] 
(1, 1) 4 
(2, 1) 5 

and> q[3,] 
(1, 1) 3 6 

and> cat (q[3,]) 
(1) 3 6 

Notice the difference in the subscripting above when cat is used. 
MacAnova also allows multidimensional arrays. Arrays are formed by the 

function array c) which takes two arguments. The first argument is the data to go 
into the array, and the second argument is a vector containing the dimensions for 
the array. The number of data values in the first argument must exactly equal the 
product of the dimensions given in the second argument. The value of the array c > 

function is an array with the data entered into the array with the first subscript · 
varying fastest. Arrays may be subscripted just like matrices, with the obvious 
exception that each subscript must be specified, not just the first two. 

Structures. In addition to scalars, vectors, matrices, and arrays, variables 
may also be structures. A structure is a variable consisting of one or more named 
components. Each of the components may be of any type: real, character, logical, 
vector, scalar, matrix, even another structure. For example, we might wish to 
keep our data in some self-describing form. Our data set, lets call it trees, could 
be stored as a structure with three components called source, names, and data. The 
source component would be a character variable giving a general description of the 
data and its source, the data component would be a matrix of real numbers 
containing the actual data, and the names component would contain the names of 
the columns in the data component matrix. 

Components of a structure are selected by using the dollar sign $ • Thus, in 
our example, trees$data is a matrix containing the data set, trees$source is a 
character variable describing the data, and (trees$names) [ 2 l is the name of the 
second column of the data set. 

The MacAnova functions describe(), split(), and cell stats() return 
structures as their values. In addition, you may create your own structures 
through the makestr () function. makestr () takes arbitrarily many arguments and 
returns as its value a structure with the arguments of makestr <) as components. 
The names of the components are the names of the arguments. 

and> source<- "made up data for example" 

and> names<- cat("species","dbh") 

and> data<- matrix(cat(l,1,1,2,2,2,5.6,4.5,8.9,7.3,9.9,11.3),6) 

6 
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Crnd> trees<- makestr(source,names,data) 

Crnd> trees 
component: source 
(1) 
made up data for example 
component: names 
(1) 
species 
(2) 
dbh 
component: data 
(1, 1) 
(2, 1) 
(3, 1) 
(4, 1) 
(5, 1) 
(6, 1) 

Crnd> trees$source 
(1) 

1 
1 
1 
2 
2 
2 

made up data for example 

Crnd> (trees$data) [1,] 

5.6 
4.5 
8.9 
7.3 
9.9 

11.3 

(1,1) 1 5.6 

Help. MacAnova has built-in help available through the Help C > function. 
Giving the command 

Crnd> Help() 

will produce a list of the topics for which help is available in MacAnova. Selecting 
Help from the File menu is equivalent to giving the command Help C > • To get help 
on a particular topic, use the Help<> function with a character variable argument 
selected from the list of topics, for example, Help ("anova"). 

External data. It is frequently useful to read data into MacAnova from a text 
file, for example, a file created by MockWrite or MacWrite. MacAnova can read 
Real data from a text file, but not Character or Logical data. Missing data may be 
included in the text file as question marks ? . The function read will read all the 
numbers in a file and return a vector containing the values from the file. The 
argument of read is a character variable giving the name of the data file. 

Crnd> x<-read("myfile") 

will read all the data from a file named myfile and put the values into x. 
MacAnova also has the ability to read columns of numbers from a file into 

separate variables. This is done via readcols. (readcols is a Macro, see Section 4.) 
The arguments to readcols are the filename, the number of columns in the data 
file, and the names of the variables into which the columns should be placed. All 
of these arguments must be character variables. Suppose that myfile has three 
columns and that we wish to read these columns into variables nam~d a, b, and c. 
Then we could type 

7 



MacAnova Version 1.0 

Ond> readcols("myfile","3","a","b","c") 

Note again that all arguments are entered as character variables. 

Simple statistics. While MacAnova is oriented towards analysis of variance, 
it does provide some simple statistical functions as well. The function describe c) 
computes the count (length), mean, variance, median, maximum, minimum, 
and upper and lower quartiles of its argument; stemleaf () produces a stem and 
leaf diagram of its argument; sort c) sorts its argument into increasing order; 
and ranki ts c) produces the rankits (normal scores) for its argument. The output 
of describe () is a structure, with components named n, min, ql, median, q3, max, 
mean, and var. 

Ond> x<-cat(2,6,4,5,8,2,3,4,l,7,8,4,3,6,5) 

Ond> describe(x) 
component: n 
(1) 15 
component: min 
(1) 1 
component: ql 
(1) 3 
component: median 
(1) 4 
component: q3 
(1) 6 
component: max 
(1) 8 
component: mean 
(1) 4.5333 
component: var 
(1) 4.6952 

Ond> describe(x)$max 
(1) 8 

Cmd> stemleaf(x) 

1 1 
3 2 
5 3 
3) 4 
7 5 
5 6 
3 7 
2 8 

Ond> sort(x) 
(1) 1 
(6) 4 
(11) 6 

Ond> rankits(x) 
(1) -0.94578 
(6) -1.245 
(11) 1.7394 

0 
00 
00 
000 
00 
00 
0 
00 

2 
4 

0.51499 
-0.7137 

6 

-0.16512 

2 
4 

7 

0 
-0.33489 

-0.51499 

3 
5 

8 

0.33489 
-1. 7394 

0. 7137 

3 
5 

8 

1.245 
0.94578 

0.16512 

There are four functions for Student's t based procedures. The functions 
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tval c) and t2val c) calculate one and two sample t statistics. The t statistic 
produced by t val c) is for the null hypotheses that the mean of its argument is 
zero. If the null hypothesis mean is other than zero, merely subtract that null 
hypothesis value from the argument. The t statistic produced by t2val c) is for the 
null hypothesis that the difference in mean of its two arguments is zero. If some 
other difference is hypothesized, subtract that value from the first argument. 
t2val c) uses a pooled estimate of the standard deviation. 

The functions tint() and t2int <> produce one and two sample t confidence 
intervals. tint c) takes two arguments, a data vector and a confidence level, and 
produces at confidence interval of the requested coverage for the mean of the data 
vector. t2int () takes three arguments, two data vectors and a confidence level, 
and produces at confidence interval of the requested coverage for the difference of 
the means of the data vectors (group one - group two) using a pooled estimate of 
the standard deviation. 

and> x<-cat(3,2,5,4,6,8,6,4,3,7,3) 

Qnd> y<-cat(7,9,6,5,7,6,9,8) 

Ond> tval(x) 
(1) 8.0437 

Qnd> tval(x-5) 
(1) -0.63088 

Qnd> t2val{x,y) 
{1) -3. 0795 

Ond> tint{x,.95) 
(1) 3.3521 5.9207 

Qnd> t2int(x,y,.99) 
(1) -4.8308 -0.1465 

P-values. MacAnova has six cumulative distribution functions (cdf) which 
can be used for computing p-values of tests. These functions are cumnor () , 
cumstu () , cumchi () , cumF () , cumbin C) , and cumpoi () for the normal, Student's t, 
chi-square, F, binomial, and poisson distributions. The arguments to these 
functions are the value of interest followed by distribution parameters. These 
parameters are degrees of freedom for the t and chi-square, numerator and 
denominator degrees of freedom for the F, sample size and probability for the 
binomial, and mean for the poisson. 

These cdf functions return the probability that a random variable would be 
less than or equal to the first argument; this is a lower-tail p-value. If you wish an 
upper-tail p-value (the usual case for the chi-square and F), take one minus the 
value of the cdf. For a two tailed z- or t-test, take two times the smaller of the 
upper and lower tail p-values. There is a macro twotailt C) (for a discussion of 
macros, see Section 4) which will compute two tailed p-values for t-tests; 
twotailt () is illustrated below. Note that arguments to a macro must be character 
variables. 

Qnd> cumnor(l.96) 
(1) 0.975 

Qnd> cumstu(2.1,10) 
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(1) 0.96896 

Cmd> twotailt("2.1","10") 
(1) 0.062077 

Cmd> cumF(4,2,10) 
(1) 0.94708 

Plotting. MacAnova includes a plotting facility with makes use of several of 
the special features of the Macintosh computer. The basic plotting function is 
plot() which takes two arguments, the x and yvalues, which must be of the same 
length. plot () then produces a scatterplot the the y variable versus the x and puts 
this plot into its own graphics window as shown below. 

Cmd> xstuff<-cat(l,2,3,4,5,6,7) 

Cmd> ystuff<-exp(xstuff) 

Cmd> plot(xstuff,ystuff) 

r S File Edit 
.. ~--n-- ...... r-----....11 111:-JI ____ 

- =D Graph 1 I 

I I 

C 

C 
1000 _ 

C eoo_ 
C 

y 600_ 
s 
t 
u 
f 400 _ 
f 

200 _ 

* 
0 ~ * * ,u ,.,. .,. 

-200 I I 
0 2 4 

xstuff 

., 

-~ 
I -

* -

-

-

* -

-

I 
6 8 

~ i2] 
•. ~::,;a!(·· 

The other plotting routine in MacAnova is boxplot c) , which produces a 
Tukey box and whisker diagram of its argument. If more than one argument is 

V 

given, parallel boxplots are produced. boxplot c) can also accept a structure as an 
argument. In this case, parallel boxplots of the components of the argument are V 
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produced. The function split<> (see Section 5) can be used for splitting one data 
vector according to the values of a second. 

Graphics windows are Macintosh windows in their own right. They may be 
moved by dragging with the mouse, resized by dragging the size box, and closed by 
clicking in the close box. (A graphics window may also be closed by selecting 
Close from the File menu.) Once you close a graphics window, it is gone until you 
reissue the plot command that created it. You do not need to close a graphics 
window to continue working in MacAnova. Selecting Command from the File 
menu will bring the Command Window to the front. You may now enter 
commands as usual. The graphics window is still on the screen, but covered up 
by the Command Window. Another approach is to select Hide from the File 
menu. This completely removes a graphics window from the screen, but 
remembers its definition. After selecting Command or Hide, a graphics window 
may be redrawn and moved to the front by selecting Graph 1 (or Graph 2 etc.) 
from the File menu. There are four graphics windows, labelled Graph 1 through 
Graph 4, which may be manipulated separately. The graphics windows are filled 
in order as you make plots. If all four graphics windows are in use, you may not 
draw more plots until one of the graphics windows is closed. (Closing in effect 
empties the window and allows another plot to use it.) 

Graphics can be printed or saved in the following ways. If you are connected 
to a printer, then pressing the 4, command (clover), and Shift keys at the same 
time will print the contents of the active window. If you press the 4, Caps Lock, 
command, and Shift keys you will print the contents of the entire screen. You 
may save the contents of a graphics window in three steps. First, select Copy from 
the Edit menu. This will place the contents of the active graphics window in a 
temporary storage area known as the clipboard. Next select Scrapbook from the 
apple(•) menu. When the Scrapbook window appears on the screen, select Paste 
from the Edit menu. This will paste the clipboard (which has your graphics 
window) into the Scrapbook. The Scrapbook is permanently stored on the disk, so 
it will not go away when you quj.t MacAnova. You may use MacWrite to paste 
your graphics images from the Scrapbook into a document (using Copy and Paste 
from the Edit menu). 

Other Macintosh features. You may edit the contents of the Command 
Window. Click the mouse to position the vertical bar anywhere you please. 
Typing will now insert characters and backspacing will delete characters from 
that location. Clicking and dragging the mouse will highlight a selection. You 
may delete the selection and copy it to the clipboard by selecting Cut from the Edit 
menu, and you may simply copy the selection to the clipboard by selecting Copy 
from the Edit menu. If you select Paste from the Edit menu, the current contents 
of the clipboard are entered into the Command Window at the location of the 
vertical bar (if any text is highlighted, Paste will write over the highlighted 
selection). 

. The most important use of these editing features is for correcting typing 
rmstakes. Suppose you have entered a long command and made a mistake. 
Instead of retyping the command, edit the incorrect version and do a Copy/Paste 
operation to copy the corrected version to the current command line. Then click 
on the end of the line with the mouse and type return. 

As you do work, the contents of the Command Window will scroll off the top 
of the screen. MacAnova saves these lines, and they can be reviewed (and edited if 
you wish) by using the scroll bar on the right side of the window. Clicking in the 
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up or down arrows scrolls up or down a couple of lines, clicking in the shaded 
region between the arrows and the square moves up or down a page, and dragging 
the square (called the thumb) moves directly to the indicated location in the text. v· 

MacAnova saves about 20000 characters from the Command Window, but the 
larger the contents of the Command Window the more slowly MacAnova will run. 
For this reason, you may wish to periodically clean up your Command Window by 
deleting unwanted material. 

V 
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3. Linear Models 

Introduction. MacAnova performs standard multiple regression and 
analysis of variance (ANOV A) calculations. Regression and ANOV A are just two 
aspects of the same basic procedure (linear models), and the MacAnova interface 
to regression and ANOV A reflects this underlying similarity. The major 
difference between the regress () and anova () functions in MacAnova is the type of 
output printed, not the underlying principles or calculations. 

Linear models (including regression and ANOVA) have a response variable 
(also called a dependent variable or target variable or Y) which is assumed to be a 
linear combination of one or more other variables (variously called the 
independent variables or predictor variables or carrier variables or X variables) 
plus random error. The random error is assumed to have zero mean and 
constant variance. To do testing, we also make the assumption that the errors 
follow a normal distribution. The least squares fit of a linear model to some data 
chooses the coefficients of the X variables so that the sum of squared errors 
between the Y data and the estimates based on the linear combination of the X 
variables is smallest. 

The distinction between regression and AN OVA lies mainly in the type of X 
variables which appear (different types ofX variables are appropriate in different 
problems). In ANOV A, the X variables are usually indicators for categories, for 
example, treatment groups in an experiment. Thus an X variable which took 
values 1,4,4,3,3,4,2 might indicate that responses 2,3, and 6 received treatment 4, 
response 7 received treatment 2 and so on. The X variable might just as have been 

V coded as A,D,D,C,C,D,B. Interest in ANOVA focusses on the mean response in 
each group or combination of groups. In regression, the X variables usually 
indicate quantities so that a 4 in an X variable means "twice as much" as a 2 in 
the sam~ X variable. Interest in regression often focusses on how much the mean 
response will change for a given change in one of the X variables. Variables 
which indicate grouping are called factors, and variables which do not indicate 
grouping are called variates. (This terminology comes from the GLIM package, 
Aitken et al. 1986.) In MacAnova, the X variables in ANOVA may be either 
factors or variates, while all X variables used in regression are assumed to be 
variates, regardless of their actual status. 

In MacAnova, a variable is a variate unless it is specifically declared to be a 
factor by using the factor c > function. For example, to create a variable b which is 
a factor assigning 6 responses alternately to two groups, you could give the 
commands 

Ond> b<-factor(cat(l,2,1,2,1,2)) 

or 

and> b<-cat(l,2,1,2,1,2) 

Ond> b<-factor(b) 

Specifying models. The functions regress () and anova () each take a single 
Character string argument containing the model to be used in the regression or 

·'-,,) ANOV A. Models are specified similarly to GLIM. A regression model has the 
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form: response variable = X variable 1 + X variable 2 + ... + X variable k. Suppose 
that we want to fit a linear model relating strength of wood dowels to their U 
diameter and density and that the data are in the variables str, diam, and density. 
We would use a regression model II str = diam + density 11

• Here diameter and 
density are both variates. The corresponding linear model is 

y i = ~o + ~ 1 X 1 i + .J32 X2i + Ei' 
Note that an intercept is automatically included in the model. Ifwe do not wish to 
have an intercept, we could use the model 11 str = diam + density - 1 11

; the" -1" 
part indicates that there should be no constant in the model. There is a limit of 10 
variables in a regression model. 

The models for the anova () function have the same basic form but are 
allowed to be more intricate. Suppose that a, b, and c are factors. Then the 
ANOVA model 11 y = a 11 is a one way classification or one way ANOVA model for 
the grouping indicated by a, and corresponds to the linear model 

y i j : Jl + o(i + E i j 
The model 11 y = a + b11 is a two way ANOVA with corresponding linear model 

y i j : Jl + o(i + J3 j + E i j 
The interaction of two factors is represented in a model by their dot product. The 
two way factorial model II y = a + b + a . b II corresponds to 

y ij : Jl + o(i + ~ j + ( o<,13) i j + E i j 
Parentheses may be used to group terms into submodels, and the dot may be 

used to combine submodels as well as factors. For example, ca +b) . c is equivalent 
toa.c + b.c, (a+b) .(c+d) isequivalenttoa.c + b.c + a.d + b.d,andsoon. Star 
notation is a shortcut for producing factorial models. If A and B are submodels, 
the A*B is equivalent to A + B + A.B. Thus, a*b*c is equivalent to a + b + a .b + c + 
a. c + b. c + a .b. c. Slash notation is a convenient shortcut for nested models: a/b 
is equivalent to a +a . b , a/b / c is equivalent to a + a . b + a. b . c , and so on. 

Terms may be removed from a model by using "subtraction". The model 
a*b*c - a.b .c is equivalent to a + b + a.b + c + a.c + b .c . Amore extensive 
form of removal is available with "minus star " subtraction, which removes not 
only the literal term as in "subtraction" but also any term which contains the 
literal term. Thus, a*b*c -* a.bis equivalent to a + b + c + a. c + b. c . 

Variates may be included in ANOVA models with the sole restriction that 
variates cannot interact (be dotted with) other variates. Variates may be dotted 
with factors or interactions of factors. A variate in an ANO VA model is usually 
referred to as a covariate, and the computations for a variate amount to 
computing the regression coefficient for the covariate. If a variate is dotted with a 
factor, a separate regression coefficient for the covariate is computed in each 
group of the factor. Suppose grp is a factor and x is a variate. Then II y = x II is to a 
simple regression model, 11 y = grp" is a one way classification model, "y = a + 
x" is a model with common slope and separate intercepts for each group, 11 y = 
a. x" is a model with a common intercept and separate slopes for each group, and 
"y = a + a. x" is a model with separate lines for·each group. 

MacAnova enforces a limit of 10 distinct variables in an ANOV A model, but 
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these variables may be combined via interaction (dotting) for up to 1024 different 
terms in the model. 

Error terms. All sums of squares and degrees of freedom not contained in 
model terms are combined into a term called ERRORl. Some models, such as split 
plot models, have more than one error term. In MacAnova, a term may be 
relabelled as an error term by enclosing it in E c ) • The only effect of this is the 
relabelling of the term in the output, and the renumbering of other error terms. 
Sums of squares are computed as usual. For example, "y = a + b + E cc) " will 
have terms a, b, ERRORl (equal to c) and ERROR2. 

Output. The regress () and anova () functions return no values. Instead, 
they print out standard summaries of their actions and set some side-effect 
variables. The output for the regress () function includes the coefficients, their 
standard errors and t statistics, the R-squared, mean square and degrees of 
freedom for error, and an ANOV A table for the regression. The output of the 
anova () function is just the ANOVA table. Examples of output follow. 

Cmd> xl<-cat(l,2,3,4,5,6,7,8,9,10) 

Cmd> x2<-cat(l,2,3,1,2,3,1,2,3,4) 

Cmd> y<-cat(2,4,5,4,3,6,7,4,5,8) 

Cmd> regress("y=xl+x2") 
Coef 

CONSTANT 1.9714 
xl 0.32698 
x2 0.46825 

N: 10 MSE: 2.0116 DF: 7 

Sequential sums of squares 

CONSTANT 
xl 
x2 
ERRORl 

R""2: 

Cmd> a<-factor(cat(l,1,1,1,2,2,2,2)) 

Cmd> b<-factor(cat(l,2,3,4,1,2,3,4)) 

Cmd> z<-cat(2,3,4,3,5,6,4,5) 

Cmd> anova("z=a+b") 

CONSTANT 
a 
b 
ERRORl 

sd 
1.1663 

0.18455 
0.54101 

0.52429 

DF 
1 
1 
1 
7 

DF 
1 
1 
3 
3 

t 
1.6904 
1. 7718 

0.86552 

ss 
230.4 

14.012 
1.5069 
14.081 

ss 
128 

8 
1 
3 

MS 
230.4 

14.012 
1.5069 
2.0116 

MS 
128 

8 
0.33333 

1 

Both regress C) and anova () set the following side-effect variables: STRMODEL 
a character variable containing the model used, TERMNAMES a character vector 
containing the names of the terms in the model, ss a real vector containing the 
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sums of squares for each term in the model, DF a real vector containing the 
degrees of freedom for each term in the model, RESIDUALS a real vector containing 
the residuals from the model, and HII a real vector containing the diagonal of the 
hat matrix. In addition, regress C) also creates REGCOEF a real vector containing 
the regression coefficients and XTXINV a real matrix containing X transpose X 
inverse, where Xis the matrix form of the independent variables. These 
side-effect variables are deleted at the beginning of each call to regress c) or 
anova c ) , so any side-effect variables that you desire to keep should be copied to a 
more permanent location prior to further work. 

Balance. A data set is balanced for a given model if the model contains only 
factors and if each factor-level combination occurs an equal number of times in 
the data set. When a data set is balanced for a model, the order of the terms in the 
model does not affect the sums of squares for the terms. 

Any model which is not balanced is called unbalanced. The sums of squares 
for terms in ~ unbalanced model may depend on the order of the terms in the 
model. When a data set is unbalanced for a model, MacAnova computes 
sequential sums of squares. Sequential sums of squares are defined to be the 
improvement iil model fit (as measured by SSE) by adding the current term to the 
model containing only the preceding terms. 

Analysis of unbalanced data can be tricky, and null hypotheses tested may 
depend on where a term occurs in a model. Several different models with the 
terms in different orders may need to be computed in order to get all necessary 
sums of squares. 

Parameterization and degrees of freedom . (Advanced topic.) MacAnova 
uses a variant of the classical (Scheffe) parameterization. Consider factors B and 
C with band c levels respectively. Factor Bis parameterized by b columns: a 
column of ones followed by b-1 columns, the ith of which has ones in the group i 
positions, minus ones in the group b positions, and zeros elsewhere. Factor C is 
parameterized similarly. The B.C interaction is parameterized by the be columns 
which are the pairwise products of the columns in the B and C parameterizations. 
(Three way interactions are three way products and so on.) A variate X is 
parameterized by X itself, and an interaction such as B.C.X is parameterized by 
the product ofX and the columns parameterizing B.C. 

The result of this parameterization is that the models fit by MacAnova are 
strictly hierarchical. It is impossible to fit the (b-l)(c-1) dimensional B.C 
interaction without fitting the main effects ofB and C, either explicitly with Band 
C terms or implicitly through the parameterization used. Hence the degrees of . 
freedom for interaction terms (and even main effects if you consider removing the 
constant) depend on which terms precede them in the model. The following table 
illustrates the degrees of freedom for various terms and models (assuming 
complete data): 

df 
Model B ~ ru:1 
B+C +B.C b-1 c-1 (b-l)(c-1) 
B + B.C + C b-1 0 b(c-1) 
B.C + B + C 0 0 bc-1 
B.C 0 0 bc-1 
B.C-1 0 0 be 
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b-1 
b 
b 

0 
0 
0 

0 
0 
b(c-1) 

For unbalanced data, the ANOV A is calculated by setting up an· X matrix as 
shown above and doing a regression, while for balanced data, the ANOV A is 
calculated by sweeping out cell means. The functions anovacoef s () and 
cellstats () described below can be used to recover the regression coefficients, cell 
means, and treatment effects. 

Contrasts. A contrast in a factor is a linear combination of the factor effects 
where the coefficients in the linear combination sum to zero. A sum of squares 
may be computed for a contrast suitable for testing the null hypothesis that the 
contrast linear combination of the true (not estimated) factor effects is zero; the 
MacAnova function contrast () computes this sum of squares. contrast C > takes 
two arguments. The first is a character variable giving the name of one of the 
factors in the current ANOVA model. This name must be given exactly as it 
appears in the ANOV A output with no leading or trailing blanks. The second 
argument is the vector of contrast coefficients. This vector must have as many 
elements as there are categories for the factor chosen, and the elements must sum 
to zero. 

If the data are unbalanced, the sum of squares for a contrast depend on what 
model terms precede the contrast in the computations. MacAnova assumes that a 
contrast occurs in a position equivalent to the first position at which the factor in 
question occurs. For example, in a contrast on factor d with model "b. c + d. c + 
e", the term b. c would precede the contrast, and the contrast sum of squares 
would be adjusted for b • c, but not for e. 

The following example of contrast is for the sample ANOV A given above: 

Cnd> contrast("b",cat(-2,1,4,-3)) 
(1) 0.15 

Cell by cell statistics. Once an ANOVA model is active, the function 
cellstats C > will compute cell by cell means, variances, and counts for user 
specified terms. The argument to cell stats c) is a character variable containing a 
term in the factors of the current ANOV A model. Note, this term need not be 
present in the model, but it must be made up of factors from the model. The 
output of cellstats () is a structure with components named mean, var, and 
count. cell stats C > works with either balanced or unbalanced data, and the result 
does not depend on the order of the terms in the model. 

The following is based on the example ANOV A model given above. The first 
example gives statistics for the 4 cells descibed by the b term, while the second 
gives statistics for the 8 (2x4) cells in the a . b term. 

Cnd> cellstats ("b") 
component: mean 
(1) 3.5 4.5 4 4 
component: var 
(1) 4.5 4.5 0 2 
component: count 
(1) 2 2 2 2 
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and> cellstats("a.b") 
component: mean 
(1, 1) 2 3 4 3 
(2, 1) 5 6 4 5 
component: var 
(1, 1) 0 0 0 0 
(2, 1) 0 0 0 0 
component: count 
(1, 1) 1 1 ·1 1 
(2, 1) 1 1 1 1 

Estimated effects. It is generally not adequate to stop after computing an 
ANOV A table; we usually want to see the estimated effects for the various terms. 
This can be done in MacAnova, but the process can be a bit awkward. Lets begin 
with the balanced case. There are four steps. First, compute the ANOV A table for 
the submode! that consists of terms completely contained in the term of interest. 
For example, suppose our model is "y=a +b+a . c+a. c. d". If a. c . d is the term of 
interest, then a +a. c is the appropriate submode!; if a. c is the term of interest, then 
a is the appropriate submode!; and if a orb is the term of interest, 1 (the constant) 
is the appropriate submodel. The second step is to save the residuals from the 
ANOV A into another variable, say res.· ·Third, compute the ANOVA table for the 
full model, but use the previous residuals res as the Y variable. Finally, use 
cell stats c) with the term of interest to get cell statistics. The cell means are the 
ANOV A effects for that term. This process is illustrated in the following example, 
where we are interested in the interaction effects in the two way factorial model. 

Cnd> anova("z=a*b") 

CONSTANT 
a 
b 
a.b 
ERRORl 

Cnd> anova("z=a+b") 

CONSTANT 
a 
b 
ERRORl 

Cnd> res<-RESIDUALS 

Cnd> anova("res=a*b") 

CONSTANT 
a 
b 
a.b 
ERRORl 

Qnd> cellstats("a.b")$mean 
(1,1) -0.5 
(2,1) 0.5 

-0.5 
0.5 

DF 
1 
1 
3 
3 
0 

DF 

18 

1 
1 
3 
3 

DF 
1 
1 
3 
3 
0 

1 
-1 

ss 
128 

8 
1 
3 
0 

ss 
128 

8 
1 
3 

ss 
0 
0 
0 
3 
0 

0 
0 

MS 
128 

8 
0.33333 

1 
0 

MS 
128 

8 
0.33333 

1 

MS 
0 
0 
0 
1 
0 
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V Note here that the cell means sum to zero across both rows and columns as pure 
interaction effects should. 

I~ 

For unbalanced data, the anovacoefs () function must be used. anovacoef s () 
prints the regression coefficients for the columns in the parameterization of the 
term as described above. These coefficients must be recombined to get the usual 
ANOV A effects. For a main effect at k levels, the parameterization is (grand 
mean, effect of level 1, effect of level 2, ... , effect of level k-1). The grand mean is 
in the model prior to any term unless it has been specifically removed, so the 
grand mean in the main effect is colinear with the first grand mean and has 
MISSING for its coefficient. The effects oflevels 1 through k-1 may be read from the 
output, and the effect of level k is obtained through the rule that the sum of the 
effects for the k levels must be zero. Thus the effect oflevel k is minus the sum of 
the effects of the first k-1 levels. If the grand mean was removed from the model 
and the term of interest is the first term in the model, then the grand mean in the 
main effect parameterization will have a nonMISSING coefficient that should be 
added to the effects of the k levels. Consider the following example. 

Ond> resp<- cat(l,2,3,4,5,6,7) 

Ond> rows<- factor(cat(l,1,2,2,3,3,3)) 

Ond> cols<- factor(cat(l,2,1,2,1,2,2)) 

Ond> anova("resp=rows*cols") 
WARNING: unbalanced data so SS are sequential 

CONSTANT 
rows 
cols 
rows.cols 
ERRORl 

Ond> anovacoefs("rows") 

DF 
1 
2 
1 
2 
1 

(1) MISSING -2.0833 -0.083333 

Ond> anovacoefs("C0NSTANT") 
(1) 3.5833 

ss 
112 

25 
2.4 
0.1 
0.5 

MS 
112 

12.5 
2.4 

0.05 
0.5 

Up to here, the grand mean (CONSTANT) is in the model, so the first element in 
the rows parameterization is MISSING. The effect for the third row is 
-(-2.0833-0.0833) = 2.16666. Now lets try it without the grand mean. 

Ond> anova("resp=rows*cols-1") 
WARNING: unbalanced data so SS are sequential 

rows 
cols 
rows.cols 
ERRORl 

Ond> anovacoefs("rows") 

DF 
3 
1 
2 
1 

(1) 3.5833 -2.0833 -0.083333 

ss 
137 
2.4 
0.1 
0.5 

MS 
45.667 

2.4 
0.05 
0.5 

rows now has three degrees of freedom, and this is reflected in the fact that the 
grand mean part of the parameterization is not MISSING and is equal to the old 

19 



MacAnova Version 1.0 

CO~STANT coefficient. 
Consider.now an interaction term, say rows.cols. Because of the product 

parameterization used for interactions, the first column of the interaction 
coefficients corresponds to the parameterization for rows, and the first row of the 
interaction corresponds to cols. Since both rows and cols precede the interaction 
in the model, the corresponding parts of the interaction are colinear with the 
preceding terms and have MISS ING coefficients. 

Cnd> anovacoefs("rows.cols") 
(1,1) MISSING MISSING 
(2,1) MISSING 0.083333 
(3,1) MISSING 0.083333 

The 0.08333 values are the interaction effects for the first two rows of the first 
column. The last row and column of interaction effects may be calculated using 
the rule that all rows and columns must add to zero. Thus the effects are 

0.0833 -0.0833 
0.0833 -0.0833 

-0.1666 0.1666 
Consider now the case where not all the terms lower in the hierarchy are included 
in the model. In this case, some of the first row or first column ·effects will be 
present and must be added into the interaction effects. 

Qnd> anova("resp=row~+rows.cols") 
WARNING: unbalanced data so SS are sequential 

CONSTANT 
rows 
rows.cols 
ERRORl 

Cnd> anovacoefs("rows.cols") 
(1,1) MISSING -0.58333 
(2,1) MISSING 0.083333 
(3,1) MISSING 0.083333 

OF 
1 
2 
3 
1 

ss 
112 

25 
2.5 
0.5 

MS 
112 

12.5 
0.83333 

0.5 

In this example the column effects have been subsumed into the interaction effect. 
Again, the column effects must sum to zero, so they are -0.58333 and 0.58333. To 
get the standard form for the interaction effect, the column effects must be added 
to the 3x2 table of interaction effects calculated above. Thus 

-0.5 0.5 
-0.5 0.5 
-0.75 0.75 

Since row effects were already in the model, rows of the interaction effects sum to 
zero. Column effects were not already in the model but are included in the 
interaction term, so columns of the interaction effects do not sum to zero. 

The general rule for computing interaction effects from anovacoef s () output 
is to first find all the highest order pure interaction effects in the table by using the 
rule that marginal sums must be zero. Then all marginal effects must be 
inspected. If any are nonMISSING, they must be added across the table of 
interaction effects. This works in any number of dimensions. 
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4. Additional Features 

Macros. A macro is a collection of commands grouped together to make it 
easy to give all the commands at once. In addition, macros take arguments that 
can be substituted into the body of the commands. This makes it easy to use a 
different set of variables each time a macro is used. 

A macro looks like a function call: the macro name followed by a 
paranthesized list of arguments. The arguments to macros must be character 
variables. When MacAnova encounters a macro in the command line, it expands 
out the list of commands stored in the macro and substitutes each of the character 
arguments for its place holder in the macro definition ($1 for argument 1, $2 for 
argument 2, and so on). If the macro mycat were cat ($1, $2) and you typed 
mycat ("12", "35"), MacAnova would expand mycat out, filling $1 and $2 to get 
cat (12, 35). Processing then continues as if you had typed cat (12, 35) to begin 
with. 

MacAnova has three builtin macros: readcols O, twotailt (), and boxcox (). 
readcols () (discussed in Section 2) allows you to read data from a file by columns 
into variables in MacAnova. The arguments are filename, number of columns, 
and column names (no more than 10). To read the data in file myfile into columns 
a, b, and c, use the command readcols ("myfile", "3", "a", "b", "c"}. twotailt () was 
also discussed in Section 2. It is a macro for computing two tailed p-values for the 
Student's t-test. The first argument is the t-value and the second argument is the 
degrees of freedom. boxcox () is a macro for computing the Box-Cox 
transformation of a set of data. It takes two arguments, the data and the Box-Cox 
parameter. 

To see the contents of a macro, use the print c > function. The argument to 
print<> is a character string containing the name of the macro or variable to be 
printed. (print () works with any variable, but is most useful for macros.) For 
example, 

Ond> print("twotailt"} 
(1) 
TMP<-cumstu($1,$2) 
if( TMP < 0.5) { 

PVAL <- 2*TMP 
} 
if ( TMP > 0 . 5) { 

PVAL <- 2*(1-TMP) 
} 
delete(TMP) 
PVAL 

The function macro() may be used to create new macros. macro() takes one 
argument, a character variable containing the commands to be grouped. The 
character variable may contain place holders $1, $2, etc. for argument substitution 
when the macro is expanded. 

Ond> tmp <- "exp(describe(log($1))$mean}" 

Ond> geomean <- macro(tmp) 

Ond> print("geomean") 
(1) 
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exp(describe(log($1))$meap) 

Cmd> y<-cat(l,2,3,4,5) 

Cmd> geomean("y") 
(1) 2.6052 
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Save and restore. All ofMacAnova's variables, macros, and so forth are kept 
in dynamic memory, not on the disk. That means that when you exit MacAnova, 
all of those variables disappear into the ether. This may be problem if you have 
spent a long time building up a set of variables. The solution is save c > and 
restore(). save() takes as an argument a character variable containing the name 
of a file into which the MacAnova variables should be saved. restore c) is the 
inverse of save (). restore () also takes a character argument giving a file name. 
If that file is a MacAnova save file, restore () will replace the current set of 
variables with those in the restore file. 

Cmd> x<-cat(l,2,3) 

Cmd> save("junk") 

Cmd> delete(x) 

Cmd> X 

UNDEFINED 

Cmd> restore("junk") 

Cmd> X 

(1) 1 2 3 

Compound lines and conditional execution. A compound line is a left. brace 
" { ", followed by one or more input lines, followed by a right brace "} " on a line by 
itself. Compound lines are used for grouping several statements together. Just as 
an individual command line has a value (which might or might not be printed 
depending on whether or not there was an assignment), a compound line has a 
value. The value of a compound line is the value of the last line in the compound 
line. No prompt is printed for the additional lines of a compound line, and no 
intermediate values are printed unless specifically requested via print<>. Thus, 

Cmd> { 
x<-6 
y<-3 
X 

} 
(1) 

Cmd> { 
X 

} 

Cmd> { 
print("x") 
print("y") 

6 
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Note that a blank line has no value and thus prints nothing. 
The principle use of compound lines is in conditionals. A conditional takes 

the form · 

Ond> if(logical) compound statement 

MacAnova evaluates the logical variable. If it is true, the compound statement is 
executed. If it is false, the compound statement is skipped. 

Qnd> if (2>1) { 
5 
} 
(1) 5 

Qnd> if(2<1) { 
3 
} 

Batch files. Batch files are external files containing one or more semicolon 
separated commands on a single command line. The commands in the file can be 
executed by giving the command 

Ond> batch("filename") 

where filename is the name of the batch file. The only advantage of batch files over 
macros is that the contents of batch files can easily be changed using a desk 
accessory like MockWrite. 
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5. Functions 

anova(Model) produces an ANOV A table for the linear model in the character 
variable Model. 

Models are specified as response= sum of terms, where terms are of the form 
n~e or name.name ..... name . Vari.ables in terms may be either factors or 
variates, though only one variate may appear in a single term. The shortcut 
formula modell *model2 expands to modell + model2 + modell .model2 , and the 
formula niodell/model2 expands to modell + modell .model2. There is a 
maximum of 10 different X variables in a model. 

Sums of squares are computed sequentially for nonbalanced designs. The 
variables RESIDUALS, HII, DF, SS, TERMNAMES, and STRMODEL are created 
as side effects of anova. 

Example: anova("y= a + b + a.b") 

Assuming a and bare factors, this will produce a two way analysis of variance 
with interaction for the response in y. 

See also anovacoefs(), cellstats(), contrast(), factor(), and regress(). 

anovacoefs(Term) extracts the model effects (regression coefficients) in an 
unbalanced ANOV A for the term specified in the character variable Term. 

A factor with k levels is parameterized by a constant and k-1 columns.for the first 
k-1 group effects. The kth effect is minus the sum of the first k-1. Interaction 
terms are parameterized as products of the main effects terms yielding arrays of 
coefficients with the leftmost subscript varying fastest. · 

Example: anova("y= a + b + a.b") 
anovacoefs(" a.b") 

This will produce the a by b interaction components. 

array(datav,dimensionv) takes the data in datav and makes an array containing 
that data with dimensions as given in the vector dimensionv. 

There must be exactly as many data in datav as the product of the dimensions in 
climensionv. The data are entered with the leftmost dimension varying fastest and 
the rightmost varying slowest. The data in datav may be of any type. 

See also matrix. 

batch(Name) executes the commands in the file with name given in the character 
variable Name. 

The commands in the file must all be on one line (separated by semicolons) or 
be a compound line. 
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boxcox("var",''Pow'') is a macro which computes the Box-Cox transformation of 
the data in var. 

Recall that the arguments to a macro must be character variables, for example, 
boxcox("x" ,"0.5"). · 

See also macro and transformations. 

boxplot(varl, var2, ... , vark) or boxplot(Struc) produces parallel Tukey boxplots for 
the variables varl through vark or the components of structure Struc. 

See also split. 

cat(a,b,c, ... ,k) concatenates the data in variables a,b, ... ,k into a single vector 
containing all the data. The arguments must all be of the same type. 

cellstats(Term) computes cell statistics of the multi way layout indicated by the 
term in the charater variable Term. 

The term must be made of factors in the current ANOVA model. The value is a 
structure with three components: mean, var, and count. Each c9niponent is an 
array with as many dimensions as there are factors in the term. The dimensions 
of the arrays correspond to the factors in the order the factors first appear in the 
ANOVA model, not in the order they are specified in Term. 

Example: anova("y=a+b+c+b.c") 
cellstats(" c.b") 

gives cell statistics for the b.c term. 

contrast(Factor,vectorc) computes the sum of squares for the contrast in the levels 
of the factor given in the character variable Factor with contrast coefficients given 
in vectorc. 

Contrast will only work if there is an active ANOVA model. If the model is 
unbalanced, the contrast sum of squares will be corrected for all terms that 
precede the first appearance of Factor in the model. 

Example: anova("y=a+b+a.b") 
contrast("b",cat(-1,1,0)) (assumingb has 3 levels) 

cumbin(Val,N,P) computes the probability that a binomial random variable with 
N trials at probability P would be less than or equal to Val. 

N must be positive but less than 1000 and P must be between zero and one. 

cumchi(Val,df) computes the probability that a chi squared random variable with 
elf degrees of freedom would be less than Val. . 

The degrees of freedom must be positive. Upper tail areas of chi squared can be 
computed as one minus cum.chi. 
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cum.F(V al,dfl,df2) computes the probability that an F random variable with dfl ~ ) 
and df2 degrees of freedom would be less than Val. ~ 

The degrees of freedom must be positive. Upper tail areas ofF can be computed as 
one minus cumF. 

cumnor(V al) computes tlie probability that a standard normal (mean zero, 
variance one) random variable would be ~ess than Val. 

Upper tail areas of the normal can be computed as one minus cumnor. 

cumpoi(Val,lambda) computes the probability that a poisson random variable with 
mean lambda would be less than or equal to Val. 

lambda must be positive. 

cumstu.(Val,df) computes the probability that at random variable with df degrees 
of freedom would be less than Val. · 

The degrees of freedom must be positive. Upper tail areas oft can be computed as 
on~ minus cumstu. Two tailed p-values for the t can be computed with the macro 
twotailt. 

See also twotailt. 

delete(varl,var2, ... ,vark) deletes the variables given as arguments and frees the U 
memory they used for other purposes. 

See also list. 

describe(Data) computes descriptive statistics for the vector of numbers given in 
Data. 

The value returned is a structure with eight components: n, min, ql, median, q3, 
max, mean, and var, where ql and q3 are the lower and upper quartiles. 

factor(x) creates a vector with contents identical to x except that the new vector is 
marked as a factor. 

The contents of x must be positive integers. The number of classes in the factor 
will be the largest integer in x. Thus both the x vectors 1,2,4 and 1,2,3,4 will 
produce factors with four classes, though only three of the classes are present in 
the first example. 

A factor indicates classes or categories, while a variate indicates quantities. 

Help(Topic) prints helpful information about the topic given in the character 
variable Topic. 

For example, Help('·'Help") will produce this text. Help() with no argum~nt will 

26 



V 

MacAnova Version 1.0 

print a list of available help topics. 

list() lists the name, type, and dimensions of all variables currently active in 
computer memory. 

See also delete. 

macro(Text) creates a macro from the commands contained iri the character 
variable Text. 

In the body of Text, references to $1, $2, and so on will be replaced (as character 
strings) by the first, second, and so on arguments when the macro is called. 
Arguments in a macro call are ALWAYS character strings. 

Example: mymacro<-macro(" cat($1,$2)") 
mymacro("l ","4") 

has as output the vector 1,4. 

makestr(varl,var2, .... ,vark) creates a structure with components named varl, 
var2, ... , vark. The values of the components are equal to varl, etc. 

matrix(datav,rowdim) makes a matrix.with rowdim rows containing the data in 
datav. · 

rowdim must exactly divide the length of the data vector. The data are entered 
with the row dimension (leftmost subscript) changi~g fastest. 

See also array(). 

plot(x,y) makes a scatterplot of the data in x and y. 

On a Macintosh, the plot may be printed by pressing Command-shift-4, or 
saved to the clipboard by selecting Copy from the Edit menu. 

print(Name) prints the variable whose name is given in the character variable 
Var. 

This function is most useful inside macros and compound lines and for printing 
macros 

rankits(x) computes rankits (normal scores) for the data in the vector x. 

plot(rankits(x),x) produces a rankit plot of x. 

read(''fname") reads numerical data from the file with name fname and creates a 
vector containing the data. 

Missing values (represented by a question mark ?) are allowed in the file. 

See also readcols. 
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readcols(''fname","ncols","varlname","var2name", ... ,"varncolsname") (a 
macro) reads numerical data from the file fname and puts the data into ncols 
variables with names given in the third and following arguments. 

The number of data values in the file must be clivisiple by ncols, ncols must be less 
than·or equal to 10, and there must be ncols variable names given. 

See also macro, read. 

regress(Model) fits the regression model given in the c~aracter variable Model. 

Model is of the form response = variable 1 + variable 2 + ... + variable k, and all X 
variables are assumed to be variates. Output includes coefficients, standard 
errors, and an ANOVA table. The variables RESIDUALS, HII, SS, DF, 
TERMNAMES, STRMODEL, REGCOEF, and XTXINV are produced as side 
effects. Regression through the origin is specified by including a "-1" in the 
model. No more than 10 X variables are allowed. 

Example: regress("y = x1 + x2 + x3") 

See also anova. 

restore(Name) d~letes all current variables and restores the variables saved into 
the file with name given in the character variable Name. 

The comm.and save(Name) must have been given prior using restore(Name). 

See also save. 

save(Name) saves the current set of variables into a file with name given in the 
character variable Name. 

See also restore. 

sort(x) sorts the data in x into ascending order. 

split(Data,Factor) splits the values in Data into separate components of a 
structure according to the values of Factor (which must be a factor). 

For example, split(cat(l,2,3,4),factor(cat(l,2,1,2))) will produce a structure with 
two components. The first, named compl, is a vector containing 1 and 3; the 
second, named comp2, is a vector containing 2 and 4. 

stemleaf(var) produces a stem and leaf diagram of the data in var. 

t2int(varl,var2,Cover) computes a (two sided) t confidence interval with coverage 
rate Cover for the mean of the data in varl minus the mean of the data in var2. 

Cover must be between zero and one. The value is a vector of length two giving the 

u 

lower and upper endpoints of the interval. . U 
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t2int computes a pooled estimate of the standard error of the difference. 

See also t2val, tval, and t2val. 

t2val(varl,var2) computes the two sample Student's t statistic for testing the null 
hypothesis that the data in varl and var2 have the same mean~ 

If the null hypothesis difference (meant~ - mean2) is something other than zero, 
say delta, then t2val(varl-delta,var2) will produce the correct t value for that null 
hypothesis. For example, if delta is 3, use t2val(varl-3,var2). 

P-values may be computed using the function cu.mstu or the macro twotailt. 

t2val computes a pooled estimate of the standard e;rror of the difference. 

See also tval, tint, t2int, cumstu, and twotailt. 

tint(var,Cover) computes a (two sided) t confidence interval with coverage rate 
Cover for the mean of the data in var. · 

Cover must be between· zero and one. The value is a vector of length two giving the 
lower and upper _endpoints of the interval. 

See also tval, t2val, and t2int. 

transformations log(x), logl 0(x), exp(x), and abs(x) produce the natural log, log 
base 10, exponential, and absolute value of the data in x. 

tval(var) computes the Student's t statistic for testing the null hypothesis that the 
data in var have mean zero. 

If the null hypothesis mean is something other than zero, say delta, then 
tval(var-delta) will produce the correct t value for that null hypothesis. For 
example, if delta is 3, use tval(var-3). 

P-values may be computed using the function cumstu or the macro twotailt. 

See also t2val, tint, t2int, cumstu, and twotailt. 

twotailt('T',"df') is a macro which computes the two tailed p-value for a t value of 
T with df degrees of freedom. 

Recall that the arguments to a macro must be character variables, for example 
twotailt("2.5" ,"21 "). ' 

See also macro and cumstu. 
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6. Examples 

Introduction. This section illustrates some of the commands and possible 
models that can be used in MacAnova. It is not a complete inventory of mo~els 
and the examples should not be construed as complete or recommended analyses. 
Many procedures (residual plots, for example) should be used in nearly every 
example, but are only used once or twice in this section to save space. The sample 
data sets are taken from Montgomery (1984) (M) or Devore and Peck (1986) (DP). 
Comments are entered in this typeface. 

Simple descriptive statistics. This is Example 19, page 95 of DP. The rem 
variable is the REM period latency and secretion indicates normal (1) or hyper (2) 
cortisol secretion. 

Qnd> rem<- cat(.5,1,2.4,5,15,19,48,83,5,5.5,6.7,13.5,31,40,47,47,59,62,68,72, 
78,84,89,105,180) 

Enter the data 
Qnd> secretion<- . 
factor(cat(2,2,2,2,2,2,2,2,1,1,1,1,1,1,1,1,1,l,1,1,1,1,1,1,1)) 

Cnd> boxplot(split(rem,secretion)) Box plots s~parately by group 

31----1---t----1---1---........ --....... - ........ --..---+---+----+ 

2.5 

2 

1.5 

1 

0.5 

o.__ _ _._ __ ...__ ______ ....__ ......... __ ..,__........, __ ..._ ______ _ 

-20 0 20 40 60 

Qnd> stemleaf(rem[secretion = 2]) 

4 
4 
2 
2 
2 

o I 1125 
10 I 59 
20 I 

30 I 
40 I 8 

80 100 120 140 160 180 200 

Could do stem and leaf (hyper secrection) 
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High: 83 

Crnd> describe(rem[secretion = 1]) 
component : n 
(1) 17 
component : min 
(1) 5 
component: ql .. · 
(1) 31 
component: median 
(1) 59 
component: q3 
(li 78 
component: max 
(1) 180 
component: mean 
(1) 58 ;394 
component: var 
(1) 1932 

or get simple descriptive statistics 
(normal secretion) 

Ond> t2val (rem [ secretion = 1] , rem [ secretion = 2] ) Two sample t test 
. (1) 2.1333 

Ond> 1-cumstu(2.1333,23) Upper tail p-value. 
(1) 0. 021896 

Simple regression. This is example 18 from page 153 of DP. The xis the 
V distance in meters from a highway and the y is the lead content of the soil in ppm. 

Ond> x<-cat(.3,1,5,10,20,25,25,30,40,50,75,100) Thedata 

Ond> y<-cat(62.75,37.51,29.70,20.71,17.65,15.41,14.15,13.50,12.11,11.40, 
10.85,10.85) 

Cmd> plot(x,y) Looks pretty curved 
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Crnd> plot (log (x) , log (y) ) Looks better 
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Crnd> logy<- log(y) 

Cmd> logx <- log(x) 

0 2 4 

Crnd> regress ("logy = logx") regression on transformed data 
Coef sd t 

CONSTANT 3.736 0.047431 78.767 
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logx -0.31472 0.015039 -20.928 

N: 12 MSE: 0.007617 OF: 10 RA2: 0. 9·7768 

Sequential sums of squares 

CONSTANT 
logx 
ERRORl 

OF 
1 
1 

10 

ss 
100.57 

3.336 
0.07617 

MS 
100.57 

3.336 
0.007617 

Cind> plot (logy-RESIDUALS, RESIDUALS) plot of residuals versus predicted 
0.2..,_ _____ i--_ ...... __ _.,. __ ..,.... __ .,._ __ ..,_ _____ i-----+-----+----+ 

·O .15 • 
0.1 • 

R • E s O .05 
I 
D • • -f. 776e • 
L 
s 
-0.05 

•• •• -0.1 

-0.15 
2.2 2.4 2.6 2.8 3 3.2 3.4 3.-6 3.8 4 4.2 

Cind> plot(rankits(RESIDUALS),RESIDUALS) rankit plot of residuals 
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Multiple regression. This data is Example 6, page 509 of DP. The two X 
variables are extractable iron and extractable aluminum; the Y variable is a 
phosphate adsorption index. 

Crnd> iron<- cat(61,175,111,124,130,173,169,169,160,244,257,333,199) 

Crnd> aluminum<- cat(13,21,24,23,64,38,33,61,39,71,112,88,54) 

Crnd> adsorption<- cat(4,18,14,18,26,26,21,30,28,36,65,62,40) 

Crnd> regress("adsorption =iron+ aluminum") 
Coef sd 

CONSTANT -7.3507 3.4847 
iron 0.11273 0.029691 
aluminum 0.349 0.071306 

t 
-2.1094 

3.7969 
4.8944 

N: 13 MSE: 19.179 DF: 10 RA2: 0.94847 

Sequential sums of squares 

CONSTANT 
iron 
aluminum 
ERRORl 

Crnd> HII 

DF 
1 
1 
1 

10 

(1) 0.30754 0.27815 0.15449 
( 6) 0 .10313 0 .12684 . 0 .13338 
(11) 0.53456 0.53144 0.086537 
Cases 11 and 12 have fairly high leverage 

Crnd> studres <- RESIDUALS/(19.179*(1-HII))A0.5 
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ss 
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MS 
11580 

3070.5 
459.43 
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0.35893 
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Cmd> studres ihtemally studentized residuals 
(1) -0.017302 -0.45867 0.11455 
(6) 0.14126 -0.54205 -0.73346 
(11) 1.4359 0.36646 1.4504 

0.82601 
0.88505 

Cmd> tres <- studres*( (13-3-1)/(13-3-studres*studres) )~o.s 

Cmd> tres externally studentized residuals (t type) 
(1) -0.016414 -0.43978 0.10875 0.8118 
(6) 0.13414 -0.52196 -0.71533 0.87459 
(11) 1.529 0.35002 1.5484 
Case 10 fits the model poorly 

Cmd> CooksD <- studres*studres*HII/(l-HII)/3 

Cmd> cooksD Cook's distance 

-1.0383 
-2.2161 

-1.0428 
-2.9471 

(1) 4.432e-005 0.027022 0.00079927 0.038588 0.20119 . 
(6) 0.00076483 0.014227 0.027598 0.025059 0.29429 
(11) 0.78937 0.050772 0.06643 
Deletion of case 11 would most influence the analysis. See Weisberg (1985) for a 
discussion of residuals and Cook's distance. 

One way ANOVA. This is example 3-1 ofM. The response is the tensile 
strength of a synthetic fiber; the experimental treatment is the percent of cotton: 
15, 20, 25, 30 or 35. There are five observations for each treatment. · 

Cmd> strength <- . 
cat(7,7,15,ll,9,12,17,12,18,18,14,18,18,19,19,19,25,22,19,23,7,10,11,15,11) 

Cmd> grp <- factor(cat(l,l,i,1,1,~,2,2,2,2,3,3,3,3,3,4,4,4,4,4,5,5,5,5,5)) 

Cmd> boxplot (split (strength, grp)) Clear differences in strength as percent 
cotton varies. 
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Cmd> anova("strength=grp") 

CONSTANT 
grp 
ERRORl 

14 16 18 20 

One-way ANOVA with 5 groups 
DF SS 

1 5655 
4 475.76 

20 161.2 

22 24 

MS 
5655 

118.94 
8.06 

26 

Cmd> contrast("grp",cat(-2,-1,0,1,2)) 
(1) 33.62 

SS for linear effect of percent (compare 
with polynomial model below) 

Cmd> cellstats("grp") Cell by cell statistics 
component: mean 
(1) 9.8 15.4 17.6 21.6 10.8 
component: var 
(1) 11.2 9.8 4.3 6.8 8.2 
component: count 
(1) 5 5 5 5 5 

Cmd> percent<- 5*grp+10 
Set up polynomials in percent cotton 

Cmd> percent2<-percent*percent 

Cmd> percent3<-percent2*percent 

Cmd> percent4<-percent3*percent 

Cmd> anova("strength=percent+percent2+percent3+percent4") 
WARNING: unbalanced data so SS are sequential 

CONSTANT 
percent 
percent2 
percent3 
percent4 

36 

DF 
1 
1 
1 
1 
1 

ss 
5655 

33.62 
343.21 

64.98 
33.946 

MS 
5655 

33.62 
343.21 

64.98 
33.946 
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ERRORl 

Ond> 1-cumF(33.95/8.06,1,20) 
(1) 0.053455 
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20 161.2 8.06 

Strict believers in 5% significance (as M apparantly is) would conclude the cubic 
term is significant and the quartic term is not. 
Ond> 1-cumF(64.98/8.06,1,20) 
(1) 0.010133 

Cmd> regress("strength=percent+percent2+percent3") polynomial regression 
. t 

CONSTANT 
percent 
percent2 
percent3 

N: 25 MSE: 9.2927 

Coef sd 
62.611 39.757 1. 5748 

-9.0114 5.1966 -1. 7341 
0.48143 0.21605 2.2284 
-0.0076 0.002874 -2.6444 

DF: 21 R"'2: 0.69363 

Sequential sums of squares 

DF ss 
CONSTANT 1 5655 
percent 1 . · 33. 62 
percent2 · 1 343.21 
percent3 1 64.98 
ERRORl 21 195.15 

MS 
5655 

33.62 
343.21 

64.98 
9.2927 

Variance stabilizing transformations. This is example 4-2, page 94 from M. 
The responses _are estimates of peak discharge during flood flow when using four 
different estimation techniques. 

Ond> discharge<-cat(.34, .12,1.23,.7,1.75,.12,.91,2.94,2.14,2.36,2.86,4.55, 
6.31,8.37,9.75,6.09,9.82,7.24,17.15,11.82,10.95,17.2,14.35,16.82) 

Ond> method<-factor(cat(l,1,1,1,1,1,2,2,2,2,2,2,3,3,3,3,3,3,4,4,4,4,4,4)) 

Ond> anova("discharge=method") 

CONST.ANT 
method 
ERRORl 

DF 
1 
3 

20 

ss 
1012.6 
708.35 
62.081 

MS 
1012.6 
236.12 
3.1041 

Cmd> plot (discharge-RESIDUALS, RESIDUALS) evidence that variance increases 
with mean response 
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Cmd> stats<-cellstats("method") 

Cmd> lmns<-log (stats$mean) log cell means 

Cmd> lsds<-log ( (stats$var) AQ. 5) log cell standard deviations 

Cmd> plot(lmns,lsds) 

I 

• IE -

IE 

I IE 
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Crnd> regress("lsds=lmns") 

CONSTANT 
lmns 

N: 4 MSE: 

Coef 
-0.27809 

0.44647 

0.017049 DF: 2 RA2: 

Sequential sums of squares 

CONSTANT 
lmns 
ERRORl 

sd 
0.10031 

0.056589 

0.96887 

DF 
1 
1 
2 

t 
-2.7724 

7.8897 

ss 
0.41659 
1.0613 

0.034098 

MS 
0.41659 
1.0613 

0.017049 

1 minus the regression coefficient is the suggested transformation.1-.44 is 
approximately a square root 
Crnd> rtdischarge<-dischargeA0.5 

Crnd> anova("rtdischarge=method") 
DF ss MS 

CONSTANT 1 120.52 120.52 
method 3 32.684 10.895 
ERRORl 20 2.6884 0.13442 

Crnd> cellstats("method") better on this scale 
component: mean 
(1) 0.75742 1. 58·2 2.8033 3.8208 
component: var 
(1) 0.16358 0.14879 0.085844 0.13947 
component: count 
(1) 6 6 6 6 

As an alternative, lets try Box-Cox transformations 
Crnd> discharge0<-boxcox("discharge","0") 

Crnd> discharge25<-boxcox("discharge","0.25") 

Crnd> dischargeS0<-boxcox("discharge","0.50") 

Crnd> discharge75<-boxcox("discharge","0.75") 

Crnd> anova("discharge0=method") 
( DF ss MS 

CONSTANT 1 370.12 370.12 
method 3 461.16 153.72 
ERRORl 20 91.958 4.5979 

Crnd> anova("discharge25=method") 
OF ss MS 

CONSTANT 1 423.29 423.29 
method 3 406.96 135.65 
ERRORl 20 46.989 2.3494 

Crnd> anova("discharge50=method") 
DF ss MS 

CONSTANT 1 486.93 486.93 
method 3 430.66 143.55 
ERRORl 20 35.424 1.7712 
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Crnd> anova("discharge75=method") 

CONSTANT 
method 
ERRORl 

DF 
1 
3 

20 

Crnd> ss<-cat(91.96,46.99,35.43,40.61,62.08) 

Crnd> pow<-cat(0,.25, .5, .75,1) 

ss 
579.9 

524.17 
40.607 

MS 
579.9 

174.72 
2.0304 

Cmd> plot (pow, ss) Plating error SS against BC parameter also suggests square 
root5.t

00 
t--___ ...,_ ___ ..,._ ___ .....,. ___ .....,. ___ ...,_ __________ -+ 

I I I I I 

80 _ 

s 60 _ 
s 

40 _ 

-

-

• 
• -

20 ____________ 1 ____ 1 _____ 1 ____ 1 _____ 1 ___ _ 

-0 • 2 0 0 • 2 0 • 4 0 • 6 0 • 8 1 1.2 
pow 

Randomized complete block. This is example 5-1, page 129 ofM. The 
response is the depth of a depression made in metal when a tip is pressed with a 
standard force into the metal. We wish to see if there are any differences in 
readings between four types of tips (treatment); we use each tip once in each of 
four metal specimens (block). 

Crnd> 
depth<-cat(9.3,9.4,9.6,10,9.4,9.3,9.8,9.9,9.2,9.4,9.5,9.7,9.7,9.6,10,10.2) 

Crnd> tip<-factor(cat(l,1,1,1,2,2,2,2,3,3,3,3,4,4,4,4)) 

Crnd> specimen<-factor(cat(l,2,3,4,1,2,3,4,1,2,3,4,1,2,3,4)) 

Crnd> anova ( "depth=specimen+tip") 

CONSTANT 
specimen 
tip 
ERRORl 

40 

DF 
1 
3 
3 
9 

ss 
1482.2 

0.825 
0.385 
0.08 

MS 
1482.2 

0.275 
0.12833 

0.0088889 

.. 

V 
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Cind> anova ("depth=tip+specimen") 

CONSTANT 

Order of terms doesn't matter when balanced 
DF SS MS 

1 1482.2 1482.2 
tip 3 0.385 0.12833 
specimen 3 0.825 0.275 
ERRORl 9 0.08 0.0088889 

Cmd> depth [ 1] <-? Make tip 1 block 1 missing, now unbalanced and order matters 

Cind> anova ( "depth=specimen+tip") block then treatment is correct 
WARNING: unbalanced data so SS are sequential 
WARNING:· cases with MISSING values deleted 

CONSTANT 
specimen 
tip 
ERRORl 

DF 
1 
3 
3 
8 

ss 
1395.9 

0.72567 
0.37611 

0.075556 

MS 
1395.9 

0.24189 
0.12537 

0.0094444 

Clnd> anova ("depth=tip+specimen") treatment then block is incorrect 
WARNING: unbalanced data so ss are sequential 
WARNING: cases with MISSING values deleted 

. DF 
CONST~ 1 
tip 3 
specimen 3 
ERRORl 8 

ss 
1395.9 

0.37317 
0.72861 

0.075556 

MS 
1395.9 

0.12439 
0.24287 

0.0094444 

Latin squares. Data from Table 5-9, page 146 ofM. Blocks are batches (rows) 
and operators (columns), treatment is mixing formulation of dynamite (letters), 
and respons_e is a measure of explosive force. 

Clnd> force<-cat(24,20,19,24,24,17,24,30,27,36,18,38,26,27,21,26,31,26,23,22, 
22,30,20,29,31) 

Clnd> operator<-factor(cat(l,2,3,4,5,1,2,3,4,5,1,2,3,4,5,1,2,3,4,5,1,2,3,4,5)) 

Ond> batches<-factor(cat(l,1,1,1,1,2,2,2,2,2,3,3,3,3,3,4,4,4,4,4,5,5,5,5,5)) 

Ond> mix<-factor(cat(l,2,3,4,5,2,3,4,5,1,3,4,5,1,2,4,5,1,2,3,5,1,2,3,4)) 

Ond> anova("force=batches+operator+mix") 
WARNING: unbalanced data so ss are sequential 

CONSTANT 
batches 
operator 
mix 
ERRORl 

DF 
1 
4 
4 
4 

12 

ss 
16129 

68 
150 
330 
128 

MS 
16129 

17 
37.5 
82.5 

10.667 

For a complete data Latin square, the order of the terms in the model does not 
matter. 

Balanced incomplete blocks. The data is from Table 6-1 of M. The response 
is elapsed time for a reaction, the blocks are batches of raw material and the 
treatments are different types of catalyst. In this example we do th; intrablock 
analysis. Always have blocks precede treatments in the model. 
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and> time<-cat(73,74,71,75,67,72,73,75,68,75,72,75) 

and> catalyst<-factor(cat(l,1,1,2,2,2,3,3,3,4,4,4)) 

Cmd> batches<-factor(cat(l,2,4,2,3,4,1,2,3,1,3,4)) 

and> anova("time=batches+catalyst") 
WARNING: unbalanced data so SS are sequential 

CONSTANT 
batches 
catalyst 
ERRORl 

Crnd> contrast("catalyst",cat(l,1,1,-3)) 
(1) 22.222 

OF 
1 
3 
3 
5 

ss 
63075 

55 
22.75 

3.25 

MS 
63075 

18.333 
7.5833 

0.65 

The catalyst four versus average of the first three catalysts contrast SS indicates 
that catalyst four must be separated from ~e other three. 

Analysis of covariance. This is example 16-1, page 480 of M. The response is 
breaking strength of a fiber, the covariate is diameter of the fiber, and there are 
three different machines (treatments) making the fibers that we would like to 
compare. 

and> strength<-cat(36,41,39,42,49,40,48,39,45,44,35,37,42,34,32) 

and> diam<-cat(20,25,24,25,32,22,28,22,30,28,21,23,26,21,15) 

and> machine<-factor(cat(l,1,1,1,1,2,2,2,2,2,3,3,3,3,3)) 

Cmd> anova("strength=machine") 

CONSTANT 
machine 
ERRORl 

analysis ignoring covariate 
DF SS 

1 24241 
2 140.4 

12 206 

MS 
24241 

70.2 
17.167 

Cmd> anova ("strength=diam+machine") Analysis with covariate (parallel lines 
model). Notice that the machine effect is much smaller after allowing for the 
covariate. 
WARNING: unbalanced data so SS are 

CONSTANT 
diam 
machine 
ERRORl 

sequential 
DF 

1 
1 
2 

11 

Cmd> anovacoef s ("diam") Slope of covariate. 
(1) 0.95399 

and> anovacoefs("machine") 
(1) MISSING 0.18241 1.2192 

42 

ss 
24241 

305.13 
13.284 
27.986 

MS 
24241 

305.13 
6.6419 
2.5442 

V 

V 
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Cind> - c .1824+1.2192) (Adjusted group effects are .18, 1.22, and-1.40) 
\....,,) (1) -1.4016 

·~ 

Cind> anova ( "strength=diam+machine. diam") Separate slopes model. 
WARNING: unbalanced data so SS are sequential 

CONSTANT 
diam 
diam.machine 
ERRORl 

DF 
1 
1 
2 

11 

ss 
24241 

305.13 
13.357 
27.913 

MS 
24241 

305.13 
6.6784 
2.5375 

Factorial models. Example 7-4, page 225 of M. The response is (a 
transformation of) volume of beverage packaged; treatments are percent 
carbonation, pressure, and speed. 

and> volume<-cat(-3,-1,0,1,5,4,-1,0,2,1,7,6,-1,0,2,3,7,9,1,1,6,5,10,11) 

Ond> percent<-factor(cat(l,1,2,2,3,3,1,1,2,2,3,3,1,1,2,2,3,3,1,1,2,2,3,3)) 

and> psi<-factor(cat(l,1,1,1,1,1,1,l,l,1,1,1,2,2,2,2,2,2,2,2,2,2,2,2)) 

Ond> speed<-factor(cat(l,1,l,1,l,1,2,2,2,2,2,2,l,1,l,1,1,1,2,2,2,2,2,2)) 

Cmd> anova("volume=percent*psi*speed") Full factorial model 
DF ss 

CONSTANT 1 234.38 
percent 2 252.75 
psi 1 45.375 
percent.psi 2 5.25 
speed 1 22.042 
percent.speed 2 0.58333 
psi.speed 1 1.0417 
percent.psi.speed 2 1.0833 
ERRORl 12 8.5 

Cmd> anova("volume=percent*psi*speed-percent.psi.speed") 
way interaction from the model and lump it into error. 

DF 
CONSTANT 1 
percent 2 
psi 1 
percent.psi 2 
speed 1 
percent.speed 2 
psi.speed 1 
ERRORl 14 

Lets get the effects for the percent. psi interaction. 
and> anova("volume=percent+psi") 

CONSTANT 
percent 
psi 
ERRORl 

Ond> res<-RESIDUALS 

DF 
1 
2 
1 

20 

ss 
234.38 
252.75 
45.375 

5.25 
22.042 

0.58333 
1.0417 
9.5833 

ss 
234.38 
252.75 
45.375 

38.5 

MS 
234.38 
126.38 
45.375 

2.625 
22.042 

0.29167 
1.0417 

0.54167 
0.70833 

Remove the three 

MS 
234.38 
126.38 
45.375 
2.625 

22.042 
0.29167 

1.0417 
0. 68452' 

MS 
234.38 
126.38 
45.375 
1.925 

V Ond> anova ( 11 res=percent *psi 11
) 
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CONSTANT 
percent 
psi 
percent.psi 
ERRORl 

Ond> cellstats("percent.psi")$mean 
(1,1) 0.625 -0.625 
(2,1) -0.125 0.125 
(3,1) -0.5 0.5 

OF 
1 
2 
1 
2 

18 

ss 
0 
0 
0 

5.25 
33.25 

MS 
0 
0 
0 

2.625 
1. 8472 

Confounding. The basic rule for computing ANOVA tables for confounded 
factorial designs is to include a factor for blocks in the model preceding the 
factorial terms. This works for complete or partial confounding. The degrees of 
freedom between blocks may be broken up into replicates and blocks within 
replicates if so desired. 

This is example 10-3 page 319 of M. It is a partially confounded 23 factorial in 
two reps, where ABC is confounded in rep 1 and AB is confounded in rep 2. 

and> y<-cat(-3,2,2,1,0,-1,-1,6,-1,0,3,5,1,0,1,1) 

and> a<-factor(cat(l,2,2,1,2,1,1,2,1,1,2,2,2,1,2,1)) 

and> b<-factor(cat(l,2,1,2,1,2,1,2,1,1,2,2,1,2,1,2)) 

and> c<-factor(cat(l,1,2,2,1,1,2,2,1,2,1,2,1,1,2,2)) 

and> rep<-factor(cat(l,1,1,1,1,1,1,1,2,2,2,2,2,2,2,2)) 

Ond> blk<-factor(cat(l,1,1,1,2,2,2,2,1,1,1,1,2,2,2,2)) 

Cmd> anova ("y=rep/blk+a*b*c") Here we have blocks nested within replicates plus 
the factorial terms. Of course, we only have half information on the partially 
confounded terms. 
WARNING: unbalanced data so SS are sequential 

CONSTANT 
rep 
rep.blk 
a 
b 
a.b 
C 
a.c 
b.c 
a.b.c 
ERRORl 

OF 
1 
1 
2 
1 
1 
1 
1 
1 
1 
1 
5 

ss 
16 

1 
2.5 

36 
20.25 

0.5 
12.25 

0.25 
1 

0.5 
3.75 

MS 
16 

1 
1.25 

36 
20.25 

0.5 
12.25 

0.25 
1 

0.5 
0.75 

Fractional factorials. Fractional factorial designs may be analyzed just like 
an ordinary factorial. Effects aliased to preceding effects will have zero degrees of 
freedom. 

The following data are from Table 11-3 of M and are from a 24-1 fractional 
factorial with defining relation l=ABCD. 

and> a<-factor(cat(l,2,1,2,1,2,1,2)) 
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Cind> b<-factor(cat(l,1,2,2,1,1,2,2)) 

Cind> c<-factor(cat(l,1,1,1,2,2,2,2)) 

Cind> d<-factor(cat(l,2,2,1,2,1,1,2)) 

Cind> y<-cat(45,100,45,65,75,60,80,96) 

Cind> anova ("y=a+b+c+d") 
WARNING: unbalanced data so SS are sequential 

OF 
CONSTANT 1 
a 1 
b 1 
C 1 
d 1 
ERRORl 3 

Cind> anova("y=d+a*b*c") 
WARNING: unbalanced data so SS are sequential 

OF 
CONSTANT 1 
d 1 
a 1 
b 1 
a.b 1 
C 1 
a.c 1 
b.c 1 
a.b.c 0 
ERRORl 0 

ss 
40044 

722 
4.5 
392 

544.5 
1408.5 

ss 
40044 
544.5 

722 
4.5 

2 
392 

684.5 
722 

0 
1. 56e-033 

MS 
40044 

722 
4.5 
392 

544.5 
469.5 

MS 
40044 
544.5 

722 
4.5 

2 
392 

684.5 
722 

0 
0 

Split plots. Split plots are experiments with a randomization restriction 
wherein one of the factors is confounded with a blocking factor. In this sense, they 
are similar to a confounded factorial. Computationally, there is no difference 
between a confounded factorial and a split plot. However, it is conventional to label 
the replicates by whole plot treatment interaction as an error term, since that 
interaction is the appropriate denominator when testing the whole plot treatment. 

The example data are a subset of Table 13-7 of M. There are two replicates, a 
whole plot treatment with three levels, and a split plot treatment with four levels. 

Cind> 
y<-cat(30,35,37,36,34,41,38,42,29,26,33,36,28,32,40,41,31,36,42,40,31,30,32,40 
) . 

Cind> rep<-factor(cat(l,1,1,1,1,1,1,1,1,1,1,1,2,2,2,2,2,2,2,2,2,2,2,2)) 

Cind> spt<-factor(cat(l,2,3,4,1,2,3,4,1,2,3,4,1,2,3,4,1,2,3,4,1,2,3,4)) 

Cind> wpt<-factor(cat(l,1,1,1,2,2,2,2,3,3,3,3,1,l,l,1,2,2,2,2,3,3,3,3)) 

Cind> anova("y=rep+wpt+E(rep.wpt)+spt+spt.wpt") 

CONSTANT 
rep 
wpt 
ERRORl 

45 

DF 
1 
1 
2 
2 

ss 
29400 

1.5 
138.25 
14.25 

MS 
29400 

1.5 
69.125 
7.125 
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3 
6 
9 

266.33 
58.417 

53.25 

88.778 
9.7361 
5.9167 

Errorl and Error2 are the whole plot and split plot errors respectively. 
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